28.10.2020
Кол-во 4 ч.
Инструкция:

1. Изучить теоретический материал, законспектировать в тетрадь;
1. Выполнить практическое задание;
1. Сделать скриншоты выполненного задания;
1. [bookmark: _GoBack]Скриншоты поместить в текстовый документ. Текстовый документ подписать с указанием даты, Ф.И.О., номером группы  наименованием учебной дисциплины;
1. Результаты отправить на почту elena.kushnerik@yandex.ru до 15.00 текущего дня.

Практическая работа
Тестирование совместимости приложений при помощи ACT 5.6
Основные возможности
[bookmark: keyword1][bookmark: keyword2][bookmark: keyword3][bookmark: keyword4][bookmark: keyword5][bookmark: keyword6][bookmark: keyword7][bookmark: keyword8][bookmark: keyword9][bookmark: keyword10]Application Compatibility Toolkit – бесплатный программный продукт, созданный компанией Microsoft для облегчения задачи сбора информации о совместимости программного и аппаратного обеспечения с такими операционными системами как Windows Vista и Windows 7. Данное приложение представляет собой клиент-серверную архитектуру. Клиентом выступает компьютер, на котором работает компонент DCP, осуществляющий сбор информации об установленном программном обеспечении и его совместимости с Windows Vista и Windows 7. В дополнении к этому, собирается информация о совместимости аппаратного обеспечения компьютера клиента. Серверная часть производит прием данных, их чтение, хранение и анализ. Хранение данных осуществляется с помощью базы данных MS SQL, обработка – с помощью модулей входящих в состав ACT 5.6.
[bookmark: keyword11]Загрузить ACT 5.6 и документацию к этому продукту можно по адресу http://www.microsoft.com/downloads/details.aspx?FamilyID=24da89e9-b581-47b0-b45e-492dd6da2971&displaylang=en
[bookmark: sect2]Системные требования
Поддерживаемые клиентские операционные системы:
· Windows 7
· Windows Vista SP1 или SP2
· Windows Server 2008 R2
· Microsoft Windows Server 2003 SP1 или SP2
· Microsoft Windows XP c Service Pack 2 или SP3
· Microsoft Windows 2000 SP4 и Update Rollup 4.
Требования к базе данных:
· [bookmark: keyword12]Microsoft SQL Server 2008
· SQL Server 2005
· SQL Server 2008 Express
· SQL Server 2005 Express Edition
[bookmark: keyword13][bookmark: keyword14][bookmark: keyword15][bookmark: keyword16][bookmark: keyword17][bookmark: keyword18]ACT 5.6 не поддерживает SQL Server 2000 или Microsoft Database Engine (MSDE).
[bookmark: keyword19][bookmark: keyword20]В дополнении необходима поддержка .Net Framework 3.5.
Рекомендуемые требования для аппаратного обеспечения:
· Непосредственно для ACT 5.6: процессор с тактовой частотой 2.8 ГГц и 2 Гб оперативной памяти
· Для базы данных – аналогичные
[bookmark: sect3]Установка
[bookmark: keyword21][bookmark: keyword22][bookmark: keyword23]Загрузив пакет, перед установкой необходимо установить SQL сервер и .Net Framwork 3.5. Установка осуществляется с помощью мастера. Во время установки необходимо задать следующие параметры:
1. SQL сервер и создать базу, в которой будет храниться информация. Окно задания параметров базы данных изображено на рис. 7.1.
[bookmark: image.7.1][image: https://www.intuit.ru/EDI/15_10_17_5/1508019676-18691/tutorial/677/objects/7/files/07_01.jpg]
Рис. 7.1.
2. Учетные записи пользователя, имеющего право запускаться в качестве службы и имеющие доступ на запись в SQL базу.
3. Папку общего доступа, для хранения лог файлов.
[bookmark: keyword24][bookmark: keyword25]По окончании установки ACT 5.6 в наше распоряжение попадает:
1. Application Compatibility Manager (ACM) – утилита позволяющая собирать, хранить и анализировать информацию поступающую от клиентов. Главное окно ACM изображено на рис. 7.2.
[bookmark: image.7.2][image: https://www.intuit.ru/EDI/15_10_17_5/1508019676-18691/tutorial/677/objects/7/files/07_02sm.jpg]
Рис. 7.2.
2. Internet Explorer Compatibility Test Tool (IECTT) – собирает веб-информацию. Интерфейс IECTT изображен на рис. 7.3.
[bookmark: image.7.3][image: https://www.intuit.ru/EDI/15_10_17_5/1508019676-18691/tutorial/677/objects/7/files/07_03.jpg]
Рис. 7.3.
3. Standard User Analyzer (SUA) – определяет проблемы совместимости, возникающие при запуске приложения под стандартной учетной записью обычного пользователя. Интерфейс SUA изображен на рис. 7.4.
[bookmark: image.7.4][image: https://www.intuit.ru/EDI/15_10_17_5/1508019676-18691/tutorial/677/objects/7/files/07_04sm.jpg]
Рис. 7.4.
4. Compatibility Administrator 32- и 64-разрядный. Интерфейс программы Compatibility Administrator изображен на рис. 7.5.
[bookmark: image.7.5][image: https://www.intuit.ru/EDI/15_10_17_5/1508019676-18691/tutorial/677/objects/7/files/07_05.jpg]Рис. 7.5.
[bookmark: keyword26]Application Compatibility Manager в свою очередь состоит из следующих компонентов:
· [bookmark: keyword27][bookmark: keyword28]Data Collection Package (DCP) – пакет установщика Windows Installer (.msi), созданный при помощи ACT. Данный файл позволяет осуществить развертывание на каждом клиентском компьютере. DCP позволяет содержать один или несколько оценщиков, по вашему выбору. Окно создания DCP изображено на рис. 7.6.
[bookmark: image.7.6][image: https://www.intuit.ru/EDI/15_10_17_5/1508019676-18691/tutorial/677/objects/7/files/07_06sm.jpg]
Рис. 7.6.
· ACT Log Processing Service – служба используемая для обслуживания лог файлов загруженных с клиентов. Данная служба, анализируя логи, вносит информацию в базу данных.
· ACT Log Processing Share – сетевой ресурс, предназначенный для хранения лог файлов.
· ACT Data Base – Microsoft SQL Server, хранящий информацию по анализируем клиентским компьютерам и приложениям.
· Microsoft Compatibility Exchange.
Типы оценщиков совместимости:
1. Сборщик информации об инвентаризации (Inventory Collector). Исследует компьютер в поисках установленных приложений, устройств.
2. [bookmark: keyword29]Оценка совместимости с контролем учетных записей (User Account Control Compatibility Evaluator – UACCE). Определяет потенциальные проблемы совместимости приложений при их использовании с контролем учетных записей (UAC).
3. Оценка совместимости обновлений (Update Compatibility Evaluator – UCE). Определяет проблемы совместимости при установке новых обновлений, установленных с Windows Update.
4. Оценщик совместимости с операционной системой Windows (Windows Compatibility Evaluator – WCE). Определяет проблемы совместимости Graphical Identification and Authentication (GINA) DLL библиотек.
Сценарий сбора информаций ACM
1. На сервер ACT 5.6 генерируется DCP пакет. В параметрах можно указать тип оценщика, периодичность сбора информации, место хранения, длительность сбора, при необходимости время начало сбора.
2. После создания DCP пакета, перед администратором стоит 2 задачи: определить компьютеры для установки DCP пакета и способ установки.
3. После первоначального сбора информации необходимо определить какие приложения будут подвержены анализу.
Создание DCP пакета не представляет особой сложности. В окне настроек необходимо задать нужные параметры и сохранить пакет в формате msi. Размер DCP пакета составляет примерно 1,5 Мб. В параметрах пакета можно задать:
1. Используемые оценщики.
· Для развертывания новой операционной системы или сервис пака – Inventory Collector, User Account Control Compatibility Evaluator и Windows Compatibility Evaluator. Использовать можно как один сборщик, так и все сразу.
· Для развертывания обновлений можно использовать: Inventory Collector и Update Compatibility Evaluator.
2. Время запуска:
· Как только возможно после установки
· В специальное время. При выборе данного параметра появляется возможность указать время начала и окончания сбора информации.
3. Длительность сбора информации: любое число не больше трех символов (от 1 до 999) с указанием дней, часов, минут.
4. Загрузка данных. Здесь можно указать через какие интервалы времени необходимо сохранять отчет на сервер, для его последующей обработки. Может принимать значение 2, 4, 8, 12 часов. Стоит обратить внимание на то, что чем меньше интервал времени информации, тем больше ее совокупный объем. При 2 часовом интервале информация одного клиента в день будет достигать 30 Мб, для 4 часового – 15. Если же указать очень длительный интервал, что если компьютер будет выключен до создания отчета вся информация за текущий период будет потеряна.
5. Место хранения: локально (подойдет для мобильных пользователей) или централизованно на сервере. При использовании первого параметра, лог файлы будет необходимо вручную скопировать в папку на сервере.
6. Ярлык – используется для определения DCP пакета, установленного на клиенте.
[bookmark: keyword30][bookmark: keyword31]После создания пакета необходимо выбрать компьютеры, на которых будет развернут DCP пакет. Здесь необходимо использовать принцип установки пакетов на самые часто используемые компьютеры в каждом подразделении или каждой логической конфигурации. Информация о совместимости приложения генерируется только во время его использования. Если данное приложение установлено, но во время сбора информации оно не используется, то и данных о нем сгенерировано не будет. Рациональней всего разбить все компьютеры на логические конфигурации. Логические конфигурации не обязательно должны совпадать с подразделениями организации. Если несколько подразделений используют одинаковые приложения, то правильнее объединить их в одну логическую конфигурацию и установить DCP пакет на несколько компьютеров, которые максимально нагружены работой и в которых используются все инспектируемые приложения.
После выбора компьютеров, которые будут участвовать в сборе информации необходимо решить, каким образом производить установку DCP пакетов. Таких способов существует несколько. Все зависит от возможности системных администраторов, их инструментов и логической карты сети (например, территориально разделенные филиалы), вот некоторые из способов установки DCP пакетов:
1. Установка вручную.
2. [bookmark: keyword32]Автоматическая установка при помощи ключей автоустановки. Осуществляется с помощью System Center Configuration Manager (или его аналогов), скриптов (VBS, JS), пакетных файлов (bat, com), инструментария WMI и других способов.
[bookmark: sect5]Классификация приложений
[bookmark: keyword33][bookmark: keyword34]После того, как DCP пакеты успешно установлены, на клиентских компьютерах производится первичная инвентаризация используемых программных и аппаратных средств. На основании этих данных необходимо выбрать приложения, которые будут участвовать в анализе совместимости. Можно определить их критерии.
1. Приоритеты анализируемых приложений:
· Критические для бизнеса – Business Critical (например, системы управления предприятием или производством).
· Важные – Important. Приложения, использование которых является если не первоочередной, то хотя бы очень важной.
· Желательно иметь – Nice to Have. Приложения, которые желательно иметь в работе.
· Не важные – Unimportant. Приложения наименьшего приоритета.
· Неуказанные – Unspecified. Неклассифицированные приложения.
2. Категории:
[bookmark: keyword35]Software Vendor – производить программного обеспечения:
· Пользовательские – Custom.
· Microsoft Corporation.
· [bookmark: keyword36]Программные продукты третьих фирм - Third Party.
· Можно создавать и свои категории.
3. Оценка совместимости:
· Нет данных
· Работает
· Работает с незначительными проблемами
· Не работает
4. Статус развертывания:
· Протестировано
· Подавлено – при использовании фиксов.
· Готово для развертывания
· Не будет развернуто
[bookmark: keyword37]Если есть подключение к Интернет, можно загрузить оценки из сообщества. Для аппаратного обеспечения поддерживаются только категории и приоритеты.
[bookmark: sect6]Исправление ошибок совместимости
[bookmark: keyword38][bookmark: keyword39]После определения несовместимых приложений необходимо принять попытку по полному устранению проблем или, хотя бы, по уменьшению последствий. Для обеспечения совместимости приложений необходимо выполнить следующие шаги:
1. Определить наиболее значимые приложения.
2. Определить проблемы совместимости.
3. [bookmark: keyword40]Решить проблемы совместимости при помощи приложений входящих в состав ACT 5.6: Internet Explorer Compatibility Test Tool (IECTT), Standard User Analyzer (SUA) и Compatibility Administrator.
4. Развернуть приложения и фиксы и протестировать их на клиентских машинах.
[bookmark: sect7]Сценарий работы Standard User Analyzer
Для примера возьмем демо приложение, позволяющее оценить проблемы совместимости и подготовить решения для их устранения. Для этой работы нам потребуется Microsoft Application Verifier. Загрузить его можно по ссылке http://www.microsoft.com/downloads/details.aspx?FamilyID=c4a25ab9-649d-4a1b-b4a7-c9d8b095df18&DisplayLang=en.
Собственно сценарий:
1. Устанавливаем Application Verifier на конечном компьютере.
2. Запускаем Standard User Analyzer.
3. [bookmark: keyword41][bookmark: keyword42]В "Target Location" указываем путь в зависимости от архитектуры "C:\Program Files (x86)\Microsoft Application Compatibility Toolkit\Compatibility Administrator (64-bit)\Demo Application\StockViewer\StockViewer.exe" или "C:\Program Files (x64)\Microsoft Application Compatibility Toolkit\Compatibility Administrator (64-bit)\Demo Application\StockViewer\StockViewer.exe". StockViewer – это и есть демо приложение, позволяющее оценить несовместимость приложений и создать заплатку к нему.
4. Делаем предварительную копию этого приложения.
5. Запускаем приложение нажатием на кнопку "Launch".
6. [bookmark: keyword43]Жмем на кнопку "Trends".
7. Далее жмем Tools -> Options, на сообщение отвечаем "Ok".
8. Потом жмем Help -> Check for update. На сообщение отвечаем "Ok".
9. Закрываем приложение.
10. Смотрим вкладки: Files, Registry, Token, Other Objects.
11. Для создания исправлений жмем Mitigation -> Apply Mitigation. Жмем "Apply".
12. Чтобы создать msi файл исправления жмем Mitigation -> Export Mitigations as MSI. Жмем "Export MSI" и указываем путь для сохранения.
13. Пакет исправлений готов. Его необходимо установить на каждом клиентском компьютере, который использует это приложение.
[bookmark: keyword44]После окончания работы с клиентом DCP пакет можно удалить.



Задание. Тестирование совместимости приложений при помощи ACT 5.6
Цель:
Осуществить инвентаризацию программного и аппаратного обеспечения организации, провести оценку совместимости.
Задачи:
1. Установка ACT 5.6. (https://cloud.mail.ru/public/4TxL/5dYBMGT2G ) 
2. Настройка.
3. Создать коллекцию.
4. Анализ логов.
Требования:
1. Установленная клиентская операционная система (одна из перечисленных):
· Windows 7
· Windows Vista SP1 или SP2
· Windows Server 2008 R2
· Microsoft Windows Server 2003 SP1 или SP2
· Microsoft Windows XP c Service Pack 2 или SP3
· Microsoft Windows 2000 SP4 и Update Rollup 4.
2. База данных SQL:
· [bookmark: keyword80]Microsoft SQL Server 2008
· SQL Server 2005
· SQL Server 2008 Express
· SQL Server 2005 Express Edition
3. .Net Framework 3.5.
4. Windows Installer 4.5.
5. Процессор с тактовой частотой 2.8 ГГц и 2 Гб оперативной памяти
Задача№1.
1. Для начала необходимо установить SQL Server и при необходимости .Net Framework 3.5.
2. Запускаем установочный файл ApplicationCompatibilityToolkitSetup.exe.
3. На шаге приветствия "Welcome to the Microsoft Application Compatibility Toolkit 5.6 Setup Wizard" жмем "Next".
4. [bookmark: keyword81]Принимаем лицензионное соглашение, поставив галочку напротив "I accept the terms in the License Agreement". Затем жмем "Next".
5. Параметры на шаге "Destination Folder" оставляем без изменений. Жмем "Next".
6. На шаге "Ready to install Microsoft Application Compatibility Toolkit 6.5" жмем "Install".
7. По окончании успешной установки жмем "Finish".
Задача№2.
1. Запускаем Application Compatibility Manager (ACM), для этого жмем Пуск -> Все программы -> Microsoft Application Compatibility Toolkit -> Application Compatibility Manager.
2. На шаге "Welcome to the ACT Configuration Wizard" жмем "Next".
3. На следующем шаге выбираем "Enterprise Configuration" и жмем "Next".
4. Далее в строке "SQL сервер" указываем имя нашего SQL сервера и жмем "Connect". В строке "Database" указываем имя создаваемой базы, например "firstdb" и жмем "Create". После успешного создания базы жмем "Next".
5. На шаге "Configure Your Log File Location" указываем местоположение папки, в которой будут храниться логии клиентов, нажатием кнопки "Browse". К примеру, это будет папка C:\LogFiles. Параметр "Share as" конфигурируется автоматически, при необходимости можем изменить его. Жмем "Next".
6. Далее необходимо указать имя учетной записи, под которой будет осуществляться запуск службы ACT Log Processing Service. Оставляем без изменения, т.е. используется пользователь "Local System". Жмем "Next".
7. На завершающем шаге при желании снимаем галочку "Send ACT usage data to Microsoft" и жмем "Finish".
Задача №3.
1. [bookmark: keyword82]В главном окне "Application Compatibility Manager Overview" жмем "Collect – Create your data collection package".
2. В открывшемся окне делаем следующие настройки:
· Name: All Collect;
· Evaluate compatibility when: Deploying a new Operation System;
· Advanced: оставляем без изменений
· Starting: As soon as possible after installation;
· Duration: 3 days;
· Upload: ever 2 hours;
· Output Location: общая папка на сервере;
· Label Collection Data: MS Word 2007;
3. [bookmark: keyword83]По окончании настройки коллекции жмем File -> Save and Create Data Collection Package. Указываем имя "All_Collectors.msi".
4. Устанавливаем пакет любым из возможных способов. Для осуществления тихой установки воспользуемся ключом /qn.
Задача №4.
1. После установки пакета на клиенте происходит автоматическое сканирование. Логи сохраняются в папку, сконфигурированную во время создания пакета.
2. На сервере ACT в Application Compatibility Manager в нижней части правой колонки выбираем "Analyze".
3. Переходим в раздел "Windows 7 Reports".
4. Выбираем "Applications".
5. Выбираем необходимое приложение. Жмем правой кнопкой мыши и выбираем "Set priority".
6. Выбираем "Priority 1 – Business Critical" и жмем "Ok".
7. При возникновении каких-либо проблем дважды жмем на приложение.
8. В открывшемся окне выбираем вкладку "Issues" и знакомимся с причинами несовместимости.
9. По каждой причине можно получить дополнительную информацию, просто выбрав ее.
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